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1 Introduction – StagCom Windows

The StagCom Windows Application is an applicatio
Windows environment, and is designed to aid th
designed by Stag.

The application utilises the remote control feature o
the programmer to take operational commands fro
keyboard to provide a fully featured Windows front-en

1.1 System Requirements

An IBM compatible - 80386 or higher processor.
4 Mbytes of free memory (minimum).

 MS-DOS 3.3 or later.
Microsoft Windows version 3.1 or later.
Hard disk with at least 1.5 Mb free.
An unused serial port.
A suitable hardware handshaking serial cable.

1.2 Interface Connections

1.2.1 Serial Cable Connections

For serial communications, the cable to be used de
that is used on the PC (either 9-pin or 25-pin).

  ! Cables that use XON/XOFF handshaking are 
StagCom Windows Application, a hardware h
described in the README.1ST file is required
StagCom Windows Application
Page 1

n that runs under the Microsoft
e use of device programmers

f the programmer, which allows
m its I/O ports instead of its

d.

pends on the type of connector

not suitable for use with
andshaking cable as
.
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1.3 StagCom Windows Application Inst

Follow the instructions given in the file README.1S
install the software in a group in the Windows Program

1.4 Programmer Configuration

The Windows package is shipped with default setting
settings are acceptable to you then you will need to c
same settings as follows.

1. Plug in the supplied power cord to the rear 

2. Connect your programmer to the Personal C
the appropriate cable (9-pin to 25-pin or 25-

3. Apply power to the programmer from the ma

4. Power up the programmer using the On/Off

5. Press I/O key, select PORT item.

6. Enter the following serial interface paramete
Port: Serial
Baud rate: 38400
Parity: None
Stop Bits: 1

7. Press ENTER key.

8. Select REMOTE CONTROL item.

9. Enter the ‘Remote’ operating mode by pres
StagCom Windows Application
Page 2

allation

T on the distribution diskette to
 Manager.

s of COM2:38400,N,8,1. If these
onfigure your programmer to the

panel socket.

omputer Interface using
pin to 25-pin serial).

ins power source.

 switch on the rear panel.

rs into your programmer:

sing I/O key again.
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1.5 Starting Up StagCom Windows Appl

When the ‘StagComWin’ icon is double-clicked in
Application will initialise itself and then attempt to esta
programmer. This is done in the background whi
displayed.
If communications are not established, then a dialog 
change current serial port settings, or to quit the applic

If communication with the programmer fails, then there

The programmer is not switched on.
Make sure the programmer is powered 

The programmer is not in remote control mode
Put the programmer in remote control m

The connecting cable is loose.
Check the connections.

The cable is in the incorrect port.
Check the cable is in the correct port bo

The port is incorrectly selected.
Ensure that the correct port is selected o
Check that the correct port is selected o
Options | programmer Comms option fro

Incompatible serial port parameters selected.
Make sure the selected baud rate, parity
and stop bits are identical for the progra

 Incorrect cable connections.
Make sure the cable used is wired in ag
README.1ST file

1.6 Leaving StagCom Windows Applicat

Leave the application by typing Alt+FX, Selecting File 
clicking the mouse on the system button (located in 
window).
StagCom Windows Application
Page 3

ication

 the Program Manager, the
blish communications with the

le the Copyright message is

box will pop-up inviting you to
ation.

 are several possible reasons:

up.

.
ode.

th on the programmer & PC.

n the programmer. 
n the PC by selecting the
m the menu.

,
mmer and the PC.

reement with the 

ion

| Exit menu items, or by double
the top left corner of the main
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2 User Interface

This Chapter will familiarise you with the operati
StagCom Windows Application main screen. The ma
status area, the menu bar, the toolbar, the response w

This Chapter also describes the use of the mouse an
keys that perform special functions within StagC
general operation of the windows user interface 
documentation and will not be repeated here. 
describes the general conventions of the Windows 
such as operation of the pull down menus, selection
dialog boxes.
StagCom Windows Application
Page 4

on of the components of the
in screen consists of the device
indow and the status bar.

d the operation of the keyboard
om Windows Application. The
is described in your windows
Your Windows documentation
Graphical User Interface (GUI)
 of file names, and operation of
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2.1 Main Screen

2.1.1 Menu Bar

The menu Chapters (Chapters 4, 5, 6, 7, 8, 9) descr
and menu option. Each of these Chapters describe th
For each menu option described, the button for that o

2.1.2 Toolbar

The Toolbar consists of a number of icons (pictures),
or option which you can use on your programmable d

             

To select an operation, move the cursor to the appro
press the mouse button once. The buttons that are
selected device will appear greyed.

When the cursor is placed over a button in the toolb
down, a description of the selected button is disp
indicator. If you do not want the button selected afte
move the cursor away from the button before releasin

2.1.3 Status Bar

The status bar will display a description of the sele
placed over a button in the button bar, or a menu 
mouse button held down, a description of the selecte
bar. If you do not want the item selected after viewin
mouse away from the button bar / menu bar before re

2.1.4 Response Window

The programmer response window keeps a record
received from the programmer. Scroll bars will appea
reached the bottom of the windows so that you can
they have scrolled off the top of the window.
StagCom Windows Application
Page 5

ibe the operation of each menu,
e options available in the menu.
ption is also shown if one exists.

 each representing an operation
evice.

priate button in the Toolbar and
 not available for the currently

ar and the mouse button is held
layed in the current selection

r viewing the button description,
g the mouse button.

cted item. When the cursor is
item in the menu bar, and the
d item is displayed in the status
g the item description, move the
leasing the mouse button.

 of messages and responses
r once the list of responses has
 view previous responses once
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2.1.5 Device Status Area

The device status area is an area in the main app
status of various options which are valid for the c
below are the options, followed by a short description

Manufacturer Currently selected manufactu
Device Currently selected device.

Programming Mode Shows the current bit mode t
Current modes supported ar
PROM type devices only. To 
Chapter 7.4 Prog. Bit Mode.

Pre Program Checks Shows which pre-program ch
device prior to programming.
Chapter 7.2 Pre Program Ch

Serialisation Shows Enabled if the serialis
otherwise shows Disabled. T
Chapter 7.5 Serialisation.

 Security Fuses Shows Enabled only if a valid
and enabled, otherwise Disa
status for devices that do sup
Chapter 7.3 Security.

EPROM Emulation Shows Enabled only if the co
emulation mode, otherwise D
programmers support this fe
operating manual for details.

Ram Start Shows the start address (in b
memory, where the first locat
assigned. This status is not a
To change this address see C

Device Start Shows the start address of th
where the first location of the
assigned. This status is not a
To change this address see C

Device Stop Shows the last address of th
where the last location of the
assigned. This status is not a
To change this address see C
StagCom Windows Application
Page 6

lication window that shows the
urrently selected device. Listed

rer.

hat the programmer is set to. 
e 8 Bit, 16 Bit & 32 Bit for 
change the current setting see 

eck shall be applied to the 
 To change the status see 
ecks.

ation feature has been enabled,
o change the status see 

 security fuse has been set 
bled is shown. To change the 
port security fuses, see 

nnected programmer is in 
isabled is shown. Not all 

ature - see your programmer 

ytes) of the programmer's 
ion of the device will be 
pplicable for PLD type devices. 
hapter 6.4 Limits.

e device (in device addresses),
 programmer's memory will be 
pplicable for PLD type devices. 
hapter 6.4 Limits.

e device (in device addresses), 
 programmer's memory will be 
pplicable for PLD type devices. 
hapter 6.4 Limits.
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2.2 Keyboard Shortcuts

Various keys on the keyboard perform special function

Arrow Keys Control the movement of the curso

Backspace Deletes the character to the left of 

Tab Within a dialog box, Tab key moves
next entry field or, if the Shift key is
to the previous field.

Alt With an underlined letter in a menu
select the item.

2.3 Dialog Box

Some of the options within StagCom Windows A
commands which are executed as soon as you select t

Many options, however, contain features that require
information. Whenever an option of this type (indica
option name in a menu) is selected, a dialog box is d
boxes control most of StagCom Windows Application's

The operation of the controls within a dialog bo
conventions and, therefore, is not documented further 
StagCom Windows Application
Page 7

s:

r.

the cursor.

 the cursor forward to the 
 pressed simultaneously, back 

 or dialog box in order to 

pplication function as simple
hem.

 the user to specify additional
ted by three periods after the
isplayed on the screen. Dialog
 features.

x follows standard Windows
here.
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3 The Basics

For those who are new to StagCom Windows Applica
place. This Chapter will not tell you everything there is
it will however, describe the basics of StagCom Window

3.1 Programming Device From File

Suppose we have an Intel 27C512 EPROM in DIP pac
floppy disk in Drive A: called ‘512.INT’ which is stored i

First of all make sure that your programmer is in r
StagCom Windows Application. Assuming that you hav
the right port settings that match the programmer, afte
messages should clear away, and the response window
in the previous StagCom session.
StagCom Windows Application
Page 8

tion, you've come to the right
 to know about the Application,

s Application.

kage, and you have a file on a
n INTEL Hex format.

emote mode, and run up the
e the Application configured to
r a few seconds, the copyright
 should show the device used
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3.1.1 Selecting Master Device

1. The first thing we need to do is select the device
case it is an Intel 27C512 in a DIP package

2. Click on the Device menu (or press Alt+D keys s

3. Click on the Select... item. (or press S key).
This will display the Select Device dialog box.

 

The dialog box is split up into two halves, The lef
of manufacturers, and the right half contains a sc
currently selected manufacturer of the left side.

4. Click on INTEL in the manufacturer list, (or use t

5. Click on 27C512-XX in the device list. (or use the

6. Finally click on the OK button (or press Enter) to

The device is now selected, and a message in the res
of this fact. If you do not have the correct programm
you may receive another message warning you tha
fitted. If this happens, place a suitable adaptor on the

You will also have noticed that the device status area
status of various options which are valid for this de
status does not display '8 Bit' then see Chapter 7.4 
Mode.
StagCom Windows Application
Page 9

 we want to program, in this 

imultaneously).

t half contains a scroll able list 
roll able list of devices for the 

he cursor keys).

 Tab key then cursor keys).

 close the dialog box.

ponse window should notify you
er adaptor fitted for this device,
t you have the wrong adaptor

 programmer.

 is now updated, displaying the
vice. If the Programming Mode
Prog. Bit Mode to set it to 8 Bit
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3.1.2 Download File To Programmer

Now that we have the correct device selected, the ne
file which we have in Floppy Drive A: called 512.int.

1. Click on the File menu (or press Alt+F keys simul

2. Click on the Send... item. (or press S key). This w
To Programmer dialog box.

3. Select Intel 16 Bit from the available I/O formats li
using the Tab key and cursor keys.

4. Select Drive A: from drives list.
5. Select 512.int from the file name list.
6. select OK button, or press Enter key.

A message box will now appear during the file transfe
file is downloaded, a message in the response windo
been transferred successfully.

3.1.3 Program Device

Now that the data has been downloaded to the progra
now be programmed. To program the device select De
+ P). After completion, a message in the response wi
program.
To program more devices just repeat 3.1.3.
StagCom Windows Application
Page 10

xt thing to do is download the

taneously).

ill display the Download File 

st, by using the mouse or by 

r to the programmer. Once the
w will confirm that the file has

mmer, the 27C512 device can
vice | Program (or press Alt D
ndow will confirm a successful
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4 File Menu

The File menu controls the flow of data into and out
provides three basic functions:

1. You can execute a batch command file

2. You can load data into the programmer from a fil

3. You can save data in the programmer to a file.

4. You can finish using (Exit) StagCom Windows Ap
StagCom Windows Application
Page 11

 of programmer. The File menu

e.

plication.
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4.1 Batch Processing

The Batch processing feature enables you to execu
sequential list of commands, so for example you co
particular device, downloads the program data file a
devices.

All commands that StagCom perform are duplic
commands. Batch files can be created with any ASCII
Windows Notepad.

If the programmer returns an error message during th
you will be prompted to specify the action is to be tak
will stop the batch file. Retry will retry the command an
command.

1.  Only one command per line is allowed.
2.  Any data after the command will be ignored and ma

comments.
3.  Commands sent and programmer responses to the

the response window so that you can monitor what
4.  The batch process can be stopped before executio

press the Escape key.
5.  Commands may be repeated ‘n’ times by placing th

command e.g. 30DV will verify the device 30 times.
6.  A pause can be added before a command is execu

e.g. 50!DP will program 50 devices with a pause be
allow the insertion of the next device into the progra

7.  Messages can be placed in the batch file to prompt
8.  The command set is not case sensitive so ‘dp’ is th
StagCom Windows Application
Page 12

te an ASCII file containing a
uld have a file that selects a
nd then programs a thousand

ated by the batch process
 editor including DOS Edit and

e execution of a batch file then
en (Abort, Retry, Ignore). Abort
d Ignore will go on to the next

y therefore be used as

 commands are displayed in
 is going on.
n of the next command by

e required count before the

ted by adding ‘!’.
tween each program cycle to
mmer socket.
 the user.
e same as ‘DP’.
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The command set is based on the menu bar short cut k

DE Device empty check.
DL Device load.
DP Device program.
DS xxxxxx Device select. xxxxxx = 6 digit de
DT Device vector test.
DV Device verify.

FR  “filepath\name” Receive file from programmer.
FRF n Set receive file i/o format n,

n = 0 = Jedec 4 = In
5 = Motorola S Record 6 = T
7 = Extended Tek Hex 8 = S
9 = ASCII Hex Space 10 = 
12 = Binary Rubout 13 = 
17 = POF 18 = 
19 = LOF.

FRR aaaaaa Ram start address where data s
receive.

FRS aaaaaa byte count (size) of received file.
FRO aaaaaaaa Offset used during file receive.
FS “filepath\name” Send file to programmer.
FSF n Send file io format (see FRF for 
FSR aaaaaa Ram start address where data s
FSS aaaaaa Max. number of bytes of file to s

send.
FSO aaaaaaaa Offset used during file send.

MC Display programmer memory CR
ME aaaaaa hh hh … Memory edit, place hex data byt

onwards.
MEF a b hh Memory edit fill ram between ad

hh.
MEU File entire memory with unprogra
MH Display programmer memory ch
ML a a a Set memory/device limits (param

devstop).
MO Display open link count.
OD “filepath” Set new data file path for connec
OL0 Serialisation - disable.
OL1 Serialisation - enable (other OL c

serialisation).
OLAD Serialisation - set ASCII Decima
OLAH Serialisation - set ASCII Hex.
OLBD Serialisation - set BCD.
OLBH Serialisation - set Hex.
OLSS Serialisation - set all Sockets Sa
StagCom Windows Application
Page 13

ey codes and are as follows:-

vice code.

tel 16
ek Hex
tag Hex
Stag Binary
Binary
Intel 32

hall be read from during file 

details).
hall be placed during send file.
tore in programmer during

C.
es hh at location aaaaaa 

dress a & b with hex data byte 

mmed state.
ecksum.
eters = ramstart devstart 

ted programmer.

ommands also enable 

l.

me.
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OLSU Serialisation - set all Sockets Un
OLSO n Serialisation - set Socket n Only.
OLBU n Serialisation - set bytes used for
OLNV Serialisation - set next serial num
OLC n aaaaaa Serialisation - configure digit n w
OLCB Serialisation - configure big Endi
OLCL Serialisation - configure Little En
OM u s w Set new bit mode, u=units per se

please see RM & SM commands
appendix of your programmer m

OP test Pre program checks, Valid option
‘OP NONE’ to disable pre
‘OP BIT’ to apply device 
‘OP EMPTY’ to apply dev

OS hh Set security fuse mask eg 01=SF
etc.

! Display the pause dialog box, inv
new device.

; Comment line (any text after oth
comments).

“user text” Displays a message on the scre
text. You can add ‘format comma
how the text is laid out. The com

\a Sound speaker
\n Start a new line
\t horizontal tab.
\\ insert \ charact
\” insert “ charact

The example
         “\aInsert device:\t\”110\\570

Will sound the horn then display
Insert device: “110\
Into programmer socket.
StagCom Windows Application
Page 14

ique.

 serial number.
ber.

ith address aaaaaa.
an.
dian.
t, s=num of sets, w=width,
 in the Remote Operation 

anual for valid modes

s are
 program checks.

illegal bit checks test
ice empty check
0, 02=SF1, C3=SF7,6,1,0 

iting the operator to insert a 

er commands are also 

en containing the entered user 
nds’ to the string to change 
mands are:
 horn.
.

er in string.
er in string.

\”\nInto programmer socket.”

570”
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4.2 Send

Click on the Send function button, The Download File
displayed.

Use Ram Start to change the default programmer ad
data will be sent. Note: this option is not available for P

Use Ram Size to limit the number of bytes in the
programmer. The default size is set to the size of RA
that all data in the file will be stored in the programmer
available for PLD type devices.

Use Offset to change the run address of the data 
default run address is the same as the RAM add
available for PLD type devices.

Use the Available I/O Formats list box to select the 
want to send to the programmer. Note: this option 
devices.

Use the Drives and Directories list boxes to locate the
StagCom Windows Application
Page 15

 To Programmer dialog box is

dress to where the first byte of
LD type devices.

 data file downloaded to the
M fitted in the programmer so
's RAM. Note: this option is not

sent to the programmer. The
ress. Note: this option is not

format of the data file that you
is not available for PLD type

 desired data file.
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4.3 Receive

Click on the Receive function button, The Upload File F
displayed.

Use Ram Start to change the default programmer ad
of data will be received. Note: This option is not availab

Use Ram Size to change the default number of bytes u
The default size = ((device size in device addresses+1
equation covers the complete range of the selected de
option is not available for PLD type devices.

Use Offset to change the run address of the data rece
default run address is the same as the RAM address.

Use the Available I/O Formats list box to select the 
want to receive from the programmer.

Use the Drives and Directories list boxes to locate th
file. When the name of the destination directory is sh
enter a filename for the data in the File Name entry fie
StagCom Windows Application
Page 16

rom Programmer dialog box is

dress from where the first byte
le for PLD type devices.

ploaded from the programmer.
) * (current bit mode/8)-1). This
vice in any bit mode. Note: this

ived from the programmer. The

format of the data file that you

e desired directory for the data
own in the File Name list box,
ld, and click on the OK button.
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4.4 Exit

Select this option to end the current StagCom Wi
returns you to the Windows Program Manager. Us
Windows Application.

Select the Exit option in the File menu. The Applicatio

Use the Return Programmer To Local Mode che
programmer to come out of remote mode and en
StagCom Windows Application has closed down. Le
want the programmer to remain in remote mode.

Click on the OK button if you want to terminate Your
Session.

Click on the Cancel button if you wish to continue
Application session.
StagCom Windows Application
Page 17

ndows Application session and
e this option to exit StagCom

n Exitdialog box is displayed.

ck-box option if you want the
ter stand-alone mode after the
ave the option unchecked if you

 StagCom Windows Application

 with your StagCom Windows
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5 Device Menu

The Device menu controls the functions that can b
programmer socket. The Device menu provides six ba

1. You can select the device for the programmer soc

2. You can program the selected device from the pro

3. You can load the selected device into the program

4. You can verify the selected device against the pro

5. You can check for the erased state of the selected

6. For PLD type devices only, you can apply downloa
device.

  ! All the above functions are reproduced in the P
dialog box. See Chapter 8.1 Prog. Commands.
StagCom Windows Application
Page 18

e applied to a device in the
sic functions:

ket.

grammer memory.

mer memory.

grammer memory.

 device.

ded test vectors to the 

rogrammer Commands
 to activate this option.
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5.1 Select

Click on the Select function button, The Select Device 

There are two methods for selecting a device,

Method One:
Use the Manufacturers list box to locate and select th
Use the Devices list box to locate and select the desire
Click on the OK button to inform the programmer tha
selected

Method Two:
Use the Manufacturers edit box to type in the ma
match will be selected in the list box.
Use the Devices edit box to type in the device nam
selected in the list box.

Notes:
The current manufacturer / device will be hi-lighted whe

A similar device will be hi-lighted when switching to a d
one available; otherwise the first device in the device li

The six digit number displayed after the device name is
this code to cross-reference with the Device Support
device you want selected.
StagCom Windows Application
Page 19

dialog box is displayed.

e desired manufacturer.
d device.
t this is the part that you want

nufacturer name, the nearest

e, the nearest match will be

n the dialog box is opened.

ifferent manufacturer if there is
st box will be hi-lighted.

 the device code, you may use
 List if you are not sure which
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5.2 Program

Select this option if you wish to program the select
will:

1. Apply pre-program checks (if they are enabled).

2. Program device from memory.

3. Apply verification checks.

4. Program security fuses (if enabled).

5. Apply test vectors (if enabled).

If the current programmer bit mode is wider than the 
Device Number dialog box will be displayed.

Select Device 0,2 to program device with even addre

Select Device 1,3 to program device with odd addres

If the serialisation option is enabled, the Select De
displayed, instead the Insert Device dialog box will 
Insert device 0, then on the next programming cycle
device 1 et cetera.

Once programming is completed, the Response Win
the status of the programming attempt.
StagCom Windows Application
Page 20

ed device. Selecting this option

selected device, then the Select

ss data.

s data.

vice Number dialog will not be
be displayed prompting you to
, you will be prompted to Insert

dow will be updated, indicating
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5.3 Load

Select this option if you wish to load the contents o
programmer memory.

If a programmer bit mode is selected which is wider 
the Select Device Number dialog box will be displayed.

Select Device 0,2 to load device into even addresses.

Select Device 1,3 to load device into odd addresses.

Once the device has been loaded, the Response Win
the status of the load attempt.
StagCom Windows Application
Page 21

f the selected device into the

than the selected device, then

dow will be updated, indicating



StagCom Operating Manual

5.4 Verify

Select this option if you wish to verify the contents of t
programmer memory.

If a programmer bit mode is selected which is wider 
the Select Device Number dialog box will be displayed.

Select Device 0,2 to verify device against even addres

Select Device 1,3 to verify device against odd address

Once the device has been verified, the Response Win
the status of the verify attempt.
StagCom Windows Application
Page 22

he selected device against the

than the selected device, then

s data.

 data.

dow will be updated, indicating
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5.5 Empty Check

Select this option if you wish to check the selected de

Once the device has been checked, the Respo
indicating the status of the empty check attempt.
StagCom Windows Application
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vice against the erased state.

nse Window will be updated,
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5.6 Vector Test

Select this option if you wish to apply test vectors to the

This option is only available for PLD type devices
downloaded to the programmer first, using a file contai

Once the vectors have been applied to the device, 
updated, indicating the status of the vector test attemp
StagCom Windows Application
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 selected device.

. Test vectors must also be
ning test vectors.

the Response Window will be
t.
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6 Memory Menu

The Memory menu controls the functions that can
memory. The Memory menu provides five basic functio

1. You can display the checksum of the data in the p
the currently set device limits.

2. You can display the C.R.C. (Cyclic Redundancy C
programmer's memory, within the currently set de
This function is not available for PLD type devices

3. You can display the Open Link Count of the data i
This function is not available for non PLD type dev

4. You can change the device addressing limits from
This function is not available to PLD type devices.

5. You can edit the contents of the programmer's me
This function is not available for PLD type devices
StagCom Windows Application
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 be applied to programmer's
ns:

rogrammer's memory, within 

heck) of the data in the
vice limits.
.

n the programmer's memory.
ices.

 the default.

mory.
.
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6.1 Checksum

Click on the Checksum function. Select this optio
checksum of the programmer's memory.

If a programmer bit mode is selected which is wider 
the Select Device Number dialog box will be displayed.

Select Device 0,2 to display the checksum of data in e

Select Device 1,3 to display the checksum of data in o

Once the checksum has been calculated, the Respo
indicating the new checksum.

For non PLD type devices, the range of the calculatio
limits, which are displayed in the Status Area. To cha
6.4 Limits.

For PLD type devices, the range of the calculation is 
the device.
StagCom Windows Application
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n if you wish to display the

than the selected device, then

ven addresses.

dd addresses.

nse Window will be updated,

n is determined by the device
nge these limits, see Chapter

the fixed to the entire range of
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6.2 Cyclic Redundancy Check (C.R.C.)

Select this option if you wish to display the C.R.C. of th

If a programmer bit mode is selected which is wider 
the Select Device Number dialog box will be displayed.

Select Device 0,2 to display the C.R.C. of data in even

Select Device 1,3 to display the C.R.C. of data in odd 

Once the C.R.C. has been calculated, the Respon
indicating the new value.

Note: This function is not available for PLD type device
StagCom Windows Application
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e programmer's memory.

than the selected device, then

 addresses.

addresses.

se Window will be updated,

s.
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6.3 Open Link Count

Select this option if you wish to display the open li
memory, for the currently selected device.

Once the open link count has been calculated, th
updated, indicating the new value.

Note: this function is only available for PLD type device
StagCom Windows Application
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nk count of the programmer's

e Response Window will be

s.
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6.4 Limits

Select this option to display the RAM And Device Limit

The Limits option is not available for PLD type devices

Use Ram Start to change the default programmer ad
of data will be accessed.

Use Device Start to change the default device start a
first be accessed.

Use Device Stop to change the last device address to
address is calculated as:
device start + ((device size in device addresses+1) 
equation covers the complete range of the selected de
StagCom Windows Application
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s dialog box.

.

dress from where the first byte

ddress from the device will be

 be accessed. The default stop

* (current bit mode/8)-1). This
vice in any selected bit mode.
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6.5 Edit

The Edit function allows you to modify the data stored
this option is not available for PLD type devices.

Selecting the Edit function to display the Edit screen.

The edit screen replaces the main screen view.

The left section of the window shows the first program
row of data. These addresses can be changed by ty
Current Address edit box, the edit box also display
edited, that is; the caret position.

The middle section displays the programmer data in h
change the value of any data, simply click on the data 
cursor keys to move about the data field. Once you ha
to change, simply type in the replacement value. To
data, simply use the PgUp & PgDn cursor keys.
StagCom Windows Application
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 in the Programmer. Note that

mer address, in hex, of each
ping the new address into the
s the address currently being

ex bytes that can be edited. To
by using the mouse, or use the
ve selected the byte you wish

 move on to the next page of
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The right section displays the same data as ASCII ch
printable, are displayed as a full stop ‘.’.  To edit the v
the data by using the mouse, or use the cursor / ta
field. Once you have selected the character byte you
the replacement character.

You cannot edit locations that are outside the ran
programmer, i.e. the last editable address is the addr
RAM: text.

Device Start shows the first programmer ram addres

Device Stop shows the last programmer ram address

6.5.1 Edit | Exit

Selecting this function will close the editing session, a
Windows Application main screen.
StagCom Windows Application
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aracters. Characters that are not
alue of any data, simply click on
b keys to move about the data
 wish to change, simply type in

ge of the ram fitted inside the
ess shown by the  Programmer

s that the device is mapped to.

 that the device is mapped to.

nd return to the main StagCom
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6.5.2 Edit | Block

6.5.2.1 Move

The Move function, allows you to copy a block of 
programmer's memory, to another location.

Selecting the Move option will display the Block Move 

Use Start Address to specify the first programmer add

Use Number Of Bytes to specify the size of the data b

Use To Address to specify the first programmer addre
StagCom Windows Application
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data from one location in the

dialog box.

ress to copy from.

lock to copy.

ss that will be over written.
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6.5.2.2 Fill

The Fill function, allows you to fill a block of data with

Selecting the Fill option will display the Fill Memory di

Use Start Address to specify the first programmer ad

Use End Address to specify the last programmer add

Use Fill Pattern to specify the data (in hex) that will
memory.

Alternately, select the Fill entire RAM with unprog
the ram in the programmer to the unprogrammed 
device, in most cases this will be FFh.
StagCom Windows Application
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 a known value.

alog box.

dress that will be over written.

ress that will be over written.

 be written to the programmer's

rammed state checkbox to set
state for the currently selected
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6.5.2.3 Goto

The Goto function, allows you to specify a new progra

Selecting the Goto option will display the Goto An Add

Use Enter The Address field to enter (in hex) the ne
to edit. The maximum address allowed is the 
programmer.
StagCom Windows Application
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mmer address to edit.

ress dialog box.

w programmer memory address
amount of RAM fitted to the
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7 Options Menu

The Options menu controls the functions that define ho
operate. The Options menu provides nine basic functio

1. You can select and configure the serial port to wh
connected.

2. You can enable and disable pre-program checks f

3. You can select and enable security fuses.

4. You can define the programmer bit mode for the s

5. You can select and configure device serialisation.

6.  You can display programming statistics.
 

7.  You can update the software in your connected pr
 

8.  You can select a new device support data file.
 

9.  You can enable and disable EPROM emulation.
StagCom Windows Application
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w other features and functions
ns:

ich the programmer is 

or the selected device.

elected device.

ogrammer.



StagCom Operating Manual

7.1 Programmer Comms.

Select the Programmer Comms option to select an
which the programmer is connected.

Selecting Programmer Comms will display the Comm

Use the Port drop-down box to select the serial 
connected to. Valid ports are Com1 .. Com4.

Use the Baud drop-down box to select the same bau
configured to.

Use the Parity drop-down box to select the same par
is configured to. Note that if parity is enabled (i.e. set t
data bits are set. The consequence is that you will n
binary format files to or from the programmer. Config
complete functionality.

Use the Stop Bits drop-down box to select the same 
configured to.
StagCom Windows Application
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d configure the serial port to

unication Setup dialog box

port that the programmer is

d rate that the programmer is

ity setting that the programmer
o even or odd) then only seven
ot be able to send or receive
ure this option to none (N) for

setting that the programmer is
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7.2 Pre Program Checks

Select the Pre-Program Checks option to define wh
device prior to programming. The current state is displ
as discussed in Chapter 2.1.5.

Selecting this option will display the Pre-Program Che

 

Select None to disable pre-program checks.

Select Illegal Bit Pattern if you wish to check the 
programmed but are required by the program data to b

Select Empty Check if you wish to check that 
programming. Contact you Stag representative for a p
this option is not enabled (greyed out).
StagCom Windows Application
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ich checks are applied to the
ayed in the Device Status Area

cks dialog box.

device for locations which are
e empty.

the device is empty before
rogrammer software update if
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7.3 Security

Select the Security option to enable or disable secu
define which fuses (from the available list) to program.

Selecting this option will display the Security Fuse Sele

Check the Enable Security Fuses check-box to enab
check-boxes.

Use the check-boxes in the Available Security Fuse
particular security fuse.

The number of available security fuses depends o
devices have no security fuses at all, in which case 
greyed out.

Note: For any security fuses to be actually programm
both the Available Security Fuse check-box has to be
Security Fuses check-box has to be checked. When
area will show Security Fuses Enabled, otherwise
Disabled.

! Some devices use the security fuse option to s
miscellaneous features. Please consult the ‘De
section in your programmer device support lis
StagCom Windows Application
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rity fuse programming and to

ction dialog box.

le the Available Security Fuses

s group to enable or disable a

n the device selected, some
the Security menu item will be

ed during the program cycle,
 checked, and also the Enable
 this occurs the Device status
 it will show Security Fuses

upport non-standard,
vice specific information’
t for further details.
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7.4 Prog. Bit Mode

Select the Prog. Bit Mode option to select a new p
default setting for the device.

Selecting this option will either display the program
single socket programmers.

or for multi-socket programmers ..

Use the list box to select the new mode required.
Note:

Select Gang mode to program all device with the 
Select Set to program each device with consecuti

This option is not available for PLD type devices.
StagCom Windows Application
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rogrammer bit mode from the

mer Bit Modes dialog box for

same data
ve memory blocks.
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7.5 Serialisation

Select Serialisation option to enable and configure pro

Selecting this option will display the Serialisation dialog

Use Enable Serialisation check-box to enable / disab

Use Type group radio buttons to define the type of the 

Select ASCII Decimal to store one decimal digit p
format.

Select ASCII Hex to store one hex digit per byte o

Select BCD to store two decimal digits per byte of
Decimal format.

Select Hex to store two hex digits per byte of mem

Use Storage group controls to specify the programm
number digits will be stored.

Use Device address to view the programmer address 
will be stored.
StagCom Windows Application
Page 40

gramming serialisation.

 box.

le serialisation function.

serial number.

er byte of memory in ASCII 

f memory in ASCII format.

 memory in Binary Coded 

ory in hex format.

er addresses where the serial

where the least significant digit
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Use Bytes Used to specify the number of the bytes res
serialisation data, bytes that are not in the current num
zero.

Use Next Value to define the next serial number to b
This value is automatically incremented after each suc

Use the Configure button to specify device addresses

Selecting the Configure button will display the Custom

Use each of the Digit edit boxes to specify a device ad
stored.

Use Reset Big Endian to configure all the digits such 
in the lowest device address (Motorola addressing).

Use Reset Little Endian to configure all the digits such
is in the lowest device address (Intel addressing).

Use Placement group controls for multi-socketed prog
serial numbers will be stored in each device / socket.

Set All socket same number to specify that all d
number programmed into them.

Set All sockets unique number to specify that e
unique umber, incremented from the previous soc

Set One socket with number to specify that only
number programmed into it. Use the Socket edit b
socket.

Please note that all variables are saved to the SCOMW
the next StagCom Windows Application session.
StagCom Windows Application
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erved in the device for the
ber range will be initialised to

e programmed into the device.
cessful programming cycle.

 for the serial number digits.

ize Serial Address dialog box.

dress where that digit will be

that the most significant digit is

 that the least significant digit

rammers to specify how the

evices/sockets have the same 

ach device/socket has a 
ket/device.

 one device/socket will have a 
ox to specify the chosen 

IN.INI file, and are reloaded in
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7.6 Statistic

Select Statistics option to display the programming a
currently selected device, that is the statistics are auto
new device is selected.

Selecting this option will display the Statistics dialog bo

Program Statistics group displays statistics relating to

Devices Handled: displays the total number of pr
including device connection failures or other non-
Devices Passed: displays the number of devices
completed a programming cycle with no errors o
Devices Failed: displays the number of devices t
correctly or have failed the post-program verify tes
Failed Pre-Prog: displays the number of devices 
programming starts. This is usually due to a part t
unprogrammed before the programming cycle sta
Failed Vector Test: This statistic is only relevant 
shows the number of devices that have unsucces
applied after the program cycle has finished.

Verify Statistics group displays statistics relating to th
function.

Devices Handled: displays the total number of ve
including device connection failures or other non-d
Devices Passed: displays the number of devices
verified against the programmer memory with no e
Devices Failed: displays the number of devices t
the programmer memory.
StagCom Windows Application
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nd verification statistics for the
matically reset to zero when a

x.

 the programming cycle.

ogramming attempts not 
device errors.
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ccurring.

hat have not programmed 
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for PLD type devices, and 
sfully passed the test vectors 
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evice errors.
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7.7 Update Programmer

Select Update Programmer option to update the prog
connected programmer. New algorithms can be obtain
representative.

Selecting this option will display the following Update P
programmer does not have an internal serial number.

Otherwise, selecting this option will display the followin
box if your programmer does have an internal serial nu

Use Authorisation Code edit box to enter the update 
from your Stag representative. When obtaining your au
to quote the programmer serial number (Programmer S

Use Update disk buttons to select the drive containing

Use Begin to begin the programmer update process, if
programmer .DAT file, then this will be used to replace
StagCom Windows Application
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ramming algorithms in the
ed from your Stag

rogrammer dialog box if your

g Update Programmer dialog
mber.

authorisation code obtained
thorisation code, you will need
/N) for your programmer.

 the programmer update disk.

 your update disk contains a
 your existing one.
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7.8 Programmer Data Files

Select Programmer Data Files option to select the co
right .DAT for the connected programmer.

Selecting this option will display the Programmer Data 

Note:  The .DAT file contains a list of devices that are s
and is used when you select a new device.
StagCom Windows Application
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rrect directory that contains the

Files Options dialog box.

upported by your programmer,
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7.9 EPROM Emulation

Select the EPROM Emulation option to enable, or d
connected programmer.

Selecting this option will toggle the state of EPROM
state (enabled or disabled) is constantly shown 
discussed in Chapter 2.1.5.

If the EPROM Emulation menu item has a tick mark
the item will remove the tick and disable the function.

If the EPROM Emulation menu item does not have a
selecting the item will add the tick and enable the func

Not all programmers support this function. If your prog
option will not be available on the Options menu.

Please consult your Programmer Operating manual fo
functionality of this command.
StagCom Windows Application
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isable EPROM emulation in the

 emulation mode. The current
in the Device Status Area as

 placed next to it, then selecting

 tick mark placed next to it, then
tion.

rammer does not, then this

r further details regarding the
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8 Window Menu

The Window menu controls the behaviour of the variou
Window menu provides four basic functions:

1. Hide / Show Programmer Commands window.

2. Hide / Show Toolbar.

3. Hide / Show Status Bar.

4. Change characteristics of the Response Window.
StagCom Windows Application
Page 46

s user interface windows. The
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8.1 Prog. Commands

Select Prog. Commands option to displays a window 
used programmer commands.

Selecting this function displays the Programmer Comm

Use this window to give you quick and easy access
programmer functions.

While the Programmer Commands window is active 
accessible via the menu bar are locked out. This fea
security from accidentally changing the characteristic
intend to change.

Done Disable (hide) Programmer Commands 
Device Select a new device.
Program Program a device from programmer me
Load Load a device into programmer memory
Verify Verify a device against programmer mem
Blank Check Check device for erased state.
Vector Test Apply vector test to PLD type device.
Send File Download data file to the programmer's
Receive File Upload data file from programmer's mem
Checksum Calculate and display checksum of prog
C.R.C. Calculate and display C.R.C. of non PLD
Link Count Calculate and display Open Link Count 
StagCom Windows Application
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giving you access to commonly

ands window.

 to the most commonly used

(displayed), the other features
ture gives you a basic level of
s of functions that you did not

Window.

mory.
.

ory.

 memory.
ory.

rammer's memory.
 type device.

of PLD type device.
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8.2 Toolbar

Select the Toolbar option to enable, or disable the Too

Selecting this option will toggle the state (hidden or sho

If the Toolbar menu item has a tick mark placed next t
remove the Toolbar from the display.

If the Toolbar menu item does not have a tick mark p
the item will add the Toolbar to the display.
StagCom Windows Application
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lbar (see Chapter 2.1.2).

wn) of the Toolbar.

o it, then selecting the item will

laced next to it, then selecting
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8.3 Status Bar

Select the Status Bar option to enable, or disable the

Selecting this option will toggle the state (hidden or sh

If the Status Bar menu item has a tick mark placed n
will remove the status bar from the display.

If the Status Bar menu item does not have a tic
selecting the item will add the status bar to the display
StagCom Windows Application
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 status bar (see Chapter 2.1.3).

own) of the status bar.

ext to it, then selecting the item

k mark placed next to it, then
.
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8.4 Response Window

Select the Response Window option to change th
Response Window.

Selecting the Response Window will display the Res
box.

As the Response window fills up with programmer re
appear in the window, and previous messages scroll o
older messages can still be reviewed by using the scro

Use No. Messages field to indicate the maximum num
the scroll range

Use Highlight Last Message check-box to keep the
window highlighted. Use this feature to give you a vis
most recent message received from the programmer.
StagCom Windows Application
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e visual characteristics of the

ponse Window Options dialog

sponse messages, scroll bars
f the top of the window. These
ll bars to scroll up the display.

ber of message to keep within

 latest entry in the Response
ual aid in keeping track of the
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9 Help Menu

The Help menu gives you access to information
Application and the Windows environment.
StagCom Windows Application
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 about the StagCom windows
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9.1 About StagCom

Select About StagCom option to display informa
Application.

Selecting the option displays the About StagCom Win

Programmer Model: displays the name of the curren

Software Revision No: displays the version of the p
connected programmer.

Serial Number: displays the serial number of the c
number when contacting you stag representative for s

Free Disk Space: displays the amount of free space 
If you have less that 10MB free, the value is displa
displayed in Megabytes.
StagCom Windows Application
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tion about StagCom Windows

dows Application dialog box.

tly connected programmer.

rogramming software within the

onnected programmer, use this
oftware updates.

on your primary hard disk.
yed in kilobytes otherwise it is
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10 Introduction – StagCom DOS

The StagCom DOS Application utilises the remote control
allowing the programmer to take operational commands fr
the keyboard to provide a fully featured DOS application.

10.1 System Requirements

An IBM compatible PC.
MS-DOS 3.2 or later.
A free serial port.
A suitable serial cable. (Stag Part No. Cable 1.)

10.2 Interface Connections

10.2.1 Serial Cable Connections

For serial communications, the cable to be used depend
that is used on the PC (either 9-pin or 25-pin).

  ! Cables that use XON/XOFF handshaking are not s
StagCom DOS Application, a hardware handshaki
the README.1ST file is required.
StagCom DOS Application
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 feature of the programmer,
om the I/O ports instead of

s on the type of connector

uitable for use with
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10.3 StagCom DOS Application Installation

  ! An appropriate .DAT file for the Programmer that yo
be placed in the same directory as the StagCom DO
application to function. This file can be found on yo
UPDATE DISK. If you do not have this disk, then co
representative.

  ! The ANSI.SYS driver is required to be installed from
for the application to display information on the sc
see your DOS documentation to install this driver c

No installation of the StagCom DOS Application is required
from the supplied floppy disk, or copy it onto your hard disk
or XCOPY commands

To execute StagCom DOS Application, type SCOMDOS fro
StagCom DOS Application
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u intend to use must
S Application for the
ur PROGRAMMER

nsult your Stag

 your CONFIG.SYS file
reen correctly, please
orrectly.

; either run the application
 by using the DOS COPY

m the DOS prompt.
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10.4 Programmer Configuration

The DOS package is shipped with default settings of C
settings are acceptable to you then you will need to config
same settings as follows.

1. Plug in the supplied power cord to the rear pane

2. Connect your programmer to the Personal Comp
the appropriate cable (9-pin to 25-pin or 25-pin to

3. Apply power to the programmer from the mains p

4. Power up the programmer using the On/Off switc

5. Press I/O key, select PORT item.

6. Enter the following serial interface parameters in
Port: Serial
Baud rate: 9600
Parity: None
Stop Bits: 1

7. Press ENTER key.

8. Select REMOTE CONTROL item, then press I/O
StagCom DOS Application
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OM1:9600,N,8,1. If these
ure the programmer to the

l socket.

uter Interface using
 25-pin serial).

ower source.

h on the rear panel.

to your programmer:

 key.
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10.5 Starting StagCom DOS Application

When you execute StagCom.exe, the application will initia
to establish communications with the programmer. If
established within 10 seconds, the Application Options gro
to either change the port settings, or to exit the application

If communication with the programmer fails, then there are

The programmer is not switched on.
Make sure the programmer is powered up.

The programmer is not in remote control mode.
Put the programmer in remote control mode.

The connecting cable is loose.
Check the connections.

The cable is in the incorrect port.
Check the cable is in the correct port both on the

The port is incorrectly selected.
Ensure that the correct port is selected on the pr
Check that the correct port is selected on the PC

Incompatible serial port parameters selected.
Make sure the selected baud rate, parity,
and stop bits are identical for the programmer an

Incorrect cable connections.
Make sure the cable used is correctly wired.

10.6 Leaving StagCom DOS Application

You may leave the application by typing Q. You will the
return the programmer to local mode, enter Y to do so, or
programmer in remote mode.
StagCom DOS Application
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lise itself and then attempt
 communications are not
up will pop-up, inviting you
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 several possible reasons:

 programmer & PC.

ogrammer.
 by pressing the X key.

d the PC.

n be asked if you wish to
 any other key to leave the
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11 User Interface

This Chapter will familiarise you with the operation o
StagCom DOS Application main screen. The main scre
options group, the application options group, the program
the programmer responses area.

This Chapter also describes the use of the keyboard 
functions within the StagCom DOS Application. The gen
command line interface is described in your DOS docu
repeated here.
StagCom DOS Application
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f the components of the
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11.1 Main Screen

11.1.1 Device Options Group

The Device Options menu, groups together all the applic
you set-up options for the selected device. If a particular
the selected device then N/A will be shown and selecti
effect.
Select the required option by pressing the key on the ke
the option.

11.1.2 Application Options Group

The Application Options menu, groups together all the 
allow you to set-up options that are not directly related t
particular option is not applicable to the mode that the p
supported by the programmer at all, then the option will no
selected. Select the required option by pressing the key 
the left of the option.

11.1.3 Programmer Commands Group

The Programmer Commands menu, groups together all 
that directly effect the selected device. If a particular com
the selected device, then the command will not be visible
Select the required command by pressing the key on the 
of the command.

11.1.4 Programmer Responses Area

The Programmer Response area either displays the re
command received by the programmer, or will display a d
are currently selecting.
StagCom DOS Application
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11.2 Keyboard Shortcuts

Various keys on the keyboard perform special functions:

Arrow Keys Control the movement of the cursor (w

Backspace Deletes the character to the left of the 

Page Up Move to the previous page of a list.

Page Down Move to the next page of a list.

Esc Cancel Current operation.

11.3 Group Menus

Some of the options within StagCom DOS Application fun
which are executed as soon as you select them.

Many options, however, contain features that require the
information. Whenever an option of this type is selected, a
the centre of the screen. Group menus control most of S
features.
StagCom DOS Application
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cursor.
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12 The Basics

For those who are new to StagCom DOS Application, you
This Chapter will not tell you everything there is to know a
however, describe the basics of StagCom DOS Applicat
this Chapter are:

Programming a Master device from a file. This section
your device, download a file to the programmer's memo
device with the pattern in the memory.

12.1 Programming Device From File

Suppose we have an Intel 27C512 EPROM in DIP packag
floppy disk in Drive A: called `512.INT' which is stored in IN

First of all make sure that your programmer is in remo
StagCom DOS Application. Assuming that you have the A
right port settings that match the programmer, after a few s
look similar to that shown at the start of Chapter 11.

12.1.1 Selecting Master Device

The first thing we need to do is select the device we want 
an Intel 27C512 in a DIP package

Under Device Options group you should see 1. Manu
keyboard to select the option.

The Device Manufacturer group menu should now ap
screen, (see fig. on next page) showing the list of vali

Locate the entry marked Intel (use the Page Up / Pag
and press the key shown to the left of the entry (h in t
StagCom DOS Application
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've come to the right place.
bout the Application, it will

ion. The topics included in

 shows you how to select
ry, and lastly program the

e, and you have a file on a
TEL Hex format.

te mode, and run up the
pplication configured to the
econds, the display should

to program, in this case it is

facturer, press 1 on the 

pear in the centre of the 
d manufactures.

e Down keys if required) 
his example).
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The Device Name/Number group menu should now ap
screen, showing the list of valid devices.
Locate the entry marked 27C512-XX (use the Page U
required) and press the key shown to the left of the entry.

The Device is now selected, and a message in the respon
this fact. If you do not have the correct programmer adapt
may receive another message warning you that you have
this happens, place a suitable adapter on the programmer

You will also have noticed that the Device Options group h
the status of various options which are valid for this device
status does not display ‘8 Bit’ then see Chapter 13.5 Bit M
StagCom DOS Application
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pear in the centre of the

p / Page Down keys if

se area should notify you of
er fitted for this device, you
 the wrong adapter fitted. If
 for the selected device.

as now updated, displaying
. If the Programming Mode

ode, to set it to ‘8 Bit’.
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12.1.2 Download File To Programmer

Now that the correct device is selected, the next thing to d
we have in Floppy Drive A: called 512.int.

Under Programmer Commands group you should see
the keyboard to select the option.

The Send File To Programmer group menu should no
the screen.

Make sure that the I/O Format is set to Intel 16 bit. If it is n

Press e to bring up the Open File menu.
StagCom DOS Application
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o is download the file which

 S. Send File, press S on 

w appear in the centre of 

ot, then see chapter 15.8.
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Notice that Programmer Responses has been replace
this shows the complete path to the currently shown d

Move to the directory where you wish to store the file 
up the directory path, or by pressing the letter preced
directory (shown with [ ] around there names).To acce
a key from the top (root) directory.

To select the file you want to download, press the lette

The Send File To Programmer group menu will now re

Press <Enter> to send the file.

During the file transfer to the programmer, the Program
show the percentage of file transferred. Once the file has 
the response window will confirm that the file has been tra

12.1.3 Program Device

Now that the data has been downloaded to the programm
now be programmed. To program the device simply press 
After completion, a message in the Programmer Resp
successful program. To program more devices, just press 
StagCom DOS Application
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d by Current File Path, 
irectory.

by pressing a. [..] to move 
ing the required sub-
ss a new disk drive, press 

r preceding its name.

-appear.

mer Responses area will
downloaded, a message in
nsferred successfully.

er, the 27C512 device can
the P key on the keyboard.
onse area will confirm a

the P key again.
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13 Device Options Group Menu

The Device Options group menu controls all options rela
The Device Options group menu has five basic options.

1. Select a new device.

2. Enabling / disabling pre program checks.

3. Configuring security fuse options.

4. Configuring programmer bit mode.

5. Configuring memory and device limits.
StagCom DOS Application
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ting to the selected device.
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13.1 Manufacturer

The Manufacturer entry displays the currently selected d
this option by pressing the 1 key to select a new manufact

Press the 1 key to display the Device Manufacturer menu g

Use the Page Up and Page Down keys to locate the page
you wish to select.

Press the key on the keyboard that precedes the man
select.

Press the Esc key to maintain the previous manufacturer s

Selecting a new manufacturer will display the Device Nam
StagCom DOS Application
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evice manufacturer, select
urer.

roup

 with the manufacturer that

ufacturer that you wish to

election.

e / Number menu group.
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13.2 Name / Number

The Name / Number entry displays the currently selecte
select this option by pressing the 2 Manufacturer key to se

Press the 2 key to display the Device Name / Number men

Use the Page Up and Page Down keys to locate the pa
wish to select.

Press the key on the keyboard that precedes the device na

Press the Esc key to maintain the previous device selectio
StagCom DOS Application
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d device name or number,
lect a new device.

u group

ge with the device that you

me that you wish to select.

n.
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13.3 Pre Prog. Checks

The Pre Prog. Checks option informs you whether pre pr
or disabled. If checks are enabled then the option will 
option will display OFF.

Press the 3 key to toggle the state of the pre program che
device prier to the program cycle.

  ! The actual checks applied depends on how the pr
These checks cannot be altered from within StagC
find out, and/or change the tests applied, consult 
StagCom DOS Application
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ogram checks are enabled
display ON, otherwise the

cks that are applied to the

ogrammer is configured.
om DOS application. To

Section 1 of this manual.
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13.4 Security

The Security option informs you whether security fuse p
disabled. If any security fuses are enabled then the op
security fuses are enabled, then this option will display OF

If the selected device has no security fuses, then this optio

Press the 4 key to display the Set Security Options group m

The menu will display the list of valid security fuses for th
fuses that have been enabled will have an asterisk (*) fol
disabled will not.

Use the letter preceding each security option to enable or 

Press the <Enter> key to close the menu when you h
changes.

Press the Esc key to cancel this menu.

  ! The number of available security fuses depends o

  ! Some devices use the security fuse option to sup
miscellaneous features. Please consult the ‘Devic
section in your programmer device support list fo
StagCom DOS Application
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rogramming is enabled or
tion will display ON. If no
F.

n will display N/A.

enu.

e selected device. Security
lowing them, those that are

disable that security fuse.

ave finished making your

n the device selected.

port non-standard,
e specific information’
r further details.
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13.5 Bit Mode

The Bit Mode option informs you which programming bit 
device. If the device is a 16 bit device (rather than 8 bit), 
bytes are mapped to the device is also shown. This o
memory devices.

Press the 5 key to display the Device Bit Mode group men

                   Menu for 8 bit devices                                                             

To change the bit mode, press the letter preceding the n
select.

For 16 bit devices, selecting Odd bit modes will place dat
d0 to d7, and data from even addresses onto d8 to d15 of
bit modes will place data from even addresses onto d0
addresses onto d8 to d15 of the device.

Press the Esc key to cancel this menu.

or
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mode will be applied to the
then the order in which the
ption is only available for

u.

    Menu for 16 bit devices

ew mode that you wish to

a from odd addresses onto
 the device. Selecting Even
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13.6 Ram Limits

The Ram Start option displays the programmer address
first byte of data will be accessed. This option is not availa

The Device Start option displays the address (in device 
device will be first be accessed. This option is not available

The Device Stop option displays the address (in device a
address to be accessed. This option is not available for PL

Press the 6, 7 or 8 key to display the Address Limits group

If key 6 was pressed, then the edit cursor will now appea
field.
If key 7 was pressed, then the edit cursor will now appear
field.
If key 8 was pressed, then the edit cursor will now appear
field.

Type in the new address and then press <Enter> to accep

Press Esc to cancel this menu.
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ble for PLD type devices.
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ddresses) of the last device
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 menu.

r over the Ram Start data

 over the Device Start data

 over the Device Stop data
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14 Application Options Group Menu

The Application Options group menu controls all options
device. The Application Options group menu has five basic

1. Set new programmer link options.

2. Set programmer ram to unprogrammed state.

3. Edit programmer ram.

4. Update device algorithms in the connected programm

5. Exit (quit) StagCom DOS Application.
StagCom DOS Application
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 not relating to the selected
 options.

er.
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14.1 Communications

The Communications option allows you change the port c
link with the programmer.

Press the X key to display the Communications group men

Use the Port letters a .. g to select the communications po
is connected. Valid ports are Com1 .. Com4, LPT1 .. LPT3

Use the Baud Rate letters h .. m to select the same baud 
configured to. 115200 baud is highly recommended for
response times.

Use the Stop Bits letters q .. r to select the same setti
configured to.

Use the Parity letters n .. p to select the same parity set
configured to.

  ! If parity is enabled (i.e. set to even or odd) then on
set. The consequence is that you will not be able 
format files to or from the programmer. Configure
complete functionality.

The current configuration is shown at the bottom of the gro
each time you change a setting.
Press Enter key to close the Communications group when
StagCom DOS Application
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onfiguration that is used to

u.

rt to which the programmer
.

rate that the programmer is
 the quickest programmer

ng that the programmer is

ting that the programmer is

ly seven data bits are
to send or receive binary
 parity option to None for

up menu, and get updated

 you have finished.
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14.2 Device Statistics

The Device Statistics option displays the programming a
the selected device, that is the statistics are reset to z
selected.

Press the D key to display the Communications group men

Program Statistics group displays statistics relating to the

Handled: displays the total number of programming a
device connection failures or other non-device errors.
Passed: displays the number of devices that have su
programming cycle with no errors occurring.
Failed Pre-Prog: displays the number of devices that
programming starts. This is usually due to a part that 
unprogrammed before the programming cycle starts.
Failed Post-Prog: displays the number of devices tha
correctly or have failed the post-program verify test.

Verify Statistics group displays statistics relating to the ve

Handled: displays the total number of verification atte
connection failures or other non-device errors.
Passed: displays the number of devices that have su
the programmer memory with no errors occurring.
Failed: displays the number of devices that have faile
programmer memory.

To Reset the statistics data to zero, select the R key.
StagCom DOS Application
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14.3 Set Ram To Unprogrammed State

The Set Entire Ram To Unprogrammed State option w
the programmer to the unprogrammed state of the curren

Press the M key to set the programmer memory to the un

There are several advantages in clearing the ram be
loading a device into the programmer.

1. If you are creating a master device from a file that do
addressing range of the device that you wish to prog
programmed into the device of an unpredictable natu

If at a later date, you program another device from th
checksums (and data content) of the second device 
master.

2. Unused areas of the device that are set to the unpro
programmed during the program cycle, hence the tim
device will be reduced.
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ill set the entire memory in
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programmed state.

fore downloading a file, or
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14.4 Edit Ram

The Edit option, invoked by pressing the E key, allows y
memory.

The edit display is broken down into three main areas.

Address This column shows the programm
byte of data of each row.

Hex Format Data This area shows the data for the s
hexadecimal format.

ASCII Format Data This area shows the data for the s
ASCII characters.

Use the SPACE bar to select the first address of the p
cursor keys to move around the hex format data area to a
edit, the currently accessed address is shown at the bott
PgUp & PgDn keys to display the next and previous page 
Use the TAB key to toggle between editing the data in hex

Note. If Programmer emulation is ON, then the data fo
updated from the programmer as you move the cursor
ensure that the editor keeps up to date with dynamic
programmer. Pages where no editable ram is fitted in th
displayed.
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Page 75
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er address for the first 

elected address in

elected address as
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14.5 Programmer Emulation

The Prog. Emulation option informs you whether programm
disabled. If programmer emulation is enabled then th
otherwise the option will display OFF.

Press the N key to toggle the state of the programmer em
your programmer user manual for more information about 

Note, This option will not be shown unless a memory d
programmer connected supports emulation via remote con
StagCom DOS Application
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er emulation is enabled or
e option will display ON,

ulation mode. Please see
emulation.

evice is selected and the
trol.
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14.6 Update Programmer

The Update Prog. option allows you update the software i

Programmer update disks are released regularly by 
representative for more information.

Press the U key to display the Communications group men

Use Authorisation Code? to enter the update authorisati
Stag representative. When obtaining your authorisation c
the programmer serial number (Programmer Serial No.) f

  ! If the connected programmer does not have an in
these items are not required and will not be displa

Use Update disk options to select the drive in which the 
located.

The programmer update process will now begin, if your u
programmer .DAT file, then this file will automatically repla

On completion of the update process the application will fin
in the usual way.
StagCom DOS Application
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nside your programmer.

Stag, contact your Stag

u.
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ode, you will need to quote
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yed.
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pdate disk also contains a
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14.7 Quit Application

To finish your StagCom DOS Application session and 
remote mode, press the Q key.

To finish your StagCom DOS Application session and retu
mode, press the Z key.

The screen will clear, and the DOS prompt will re-appear.
StagCom DOS Application
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14.8 Batch Processing

The Batch processing feature enables you to execute 
sequential list of commands, so for example you could
particular device, downloads the program data file and 
devices.

All commands that StagCom perform are duplicate
commands. Batch files can be created with any ASCII ed
Windows Notepad.

If the programmer returns an error message during the ex
you will be prompted to specify the action is to be taken (
will stop the batch file. Retry will retry the command and I
command.

1.  Only one command per line is allowed.
2.  Any data after the command will be ignored and may th

comments.
3.  Commands sent and programmer responses to the co

the response window so that you can monitor what is g
4.  The batch process can be stopped before execution of

press the Escape key.
5.  Commands may be repeated ‘n’ times by placing the re

command e.g. 30DV will verify the device 30 times.
6.  A pause can be added before a command is executed

e.g. 50!DP will program 50 devices with a pause betwe
allow the insertion of the next device into the programm

7.  Messages can be placed in the batch file to prompt the
8.  The command set is not case sensitive so ‘dp’ is the sa
StagCom DOS Application
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an ASCII file containing a
 have a file that selects a
then programs a thousand

d by the batch process
itor including DOS Edit and

ecution of a batch file then
Abort, Retry, Ignore). Abort
gnore will go on to the next

erefore be used as

mmands are displayed in
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 the next command by

quired count before the

 by adding ‘!’.
en each program cycle to
er socket.
 user.
me as ‘DP’.
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The command set is based on the menu bar short cut key 

DE Device empty check.
DL Device load.
DP Device program.
DS xxxxxx Device select. xxxxxx = 6 digit devic
DT Device vector test.
DV Device verify.

FR  “filepath\name” Receive file from programmer.
FRF n Set receive file i/o format n,

n = 0 = Jedec 4 = Intel 
5 = Motorola S Record 6 = Tek H
7 = Extended Tek Hex 8 = Stag
9 = ASCII Hex Space 10 = Sta
12 = Binary Rubout 13 = Bin
17 = POF 18 = Inte
19 = LOF.

FRR aaaaaa Ram start address where data shall 
receive.

FRS aaaaaa byte count (size) of received file.
FRO aaaaaaaa Offset used during file receive.
FS “filepath\name” Send file to programmer.
FSF n Send file io format (see FRF for deta
FSR aaaaaa Ram start address where data shall 
FSS aaaaaa Max. number of bytes of file to store

send.
FSO aaaaaaaa Offset used during file send.

MC Display programmer memory CRC.
ME aaaaaa hh hh … Memory edit, place hex data bytes h

onwards.
MEF a b hh Memory edit fill ram between addres

hh.
MEU File entire memory with unprogramm
MH Display programmer memory check
ML a a a Set memory/device limits (paramete

devstop).
MO Display open link count.
OD “filepath” Set new data file path for connected
OM u s w Set new bit mode, u=units per set, s

please see RM & SM commands in 
appendix of your programmer manu

OP test Pre program checks, Valid options a
‘OP NONE’ to disable pre pr
‘OP BIT’ to apply device illeg
‘OP EMPTY’ to apply device
StagCom DOS Application
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codes and are as follows:-

e code.

16
ex

 Hex
g Binary
ary
l 32

be read from during file 

ils).
be placed during send file.
 in programmer during

h at location aaaaaa 

s a & b with hex data byte 

ed state.
sum.
rs = ramstart devstart 

 programmer.
=num of sets, w=width,
the Remote Operation 
al for valid modes
re
ogram checks.
al bit checks test
 empty check
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OS hh Set security fuse mask eg 01=SF0, 
etc.

! Display the pause dialog box, invitin
new device.

; Comment line (any text after other c
comments).

“user text” Displays a message on the screen c
text. You can add ‘format commands
how the text is laid out. The comman

\a Sound speaker ho
\n Start a new line.
\t horizontal tab.
\\ insert \ character in
\” insert “ character in

The example
         “\aInsert device:\t\”110\\570\”\n

Will sound the horn then display
Insert device: “110\570
Into programmer socket.
StagCom DOS Application
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02=SF1, C3=SF7,6,1,0 

g the operator to insert a 

ommands are also 

ontaining the entered user 
’ to the string to change 
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rn.

 string.
 string.

Into programmer socket.”
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15 Programmer Commands Group Me

The Programmer Commands group menu controls all 
selected device. The Programmer Commands group menu

1. Program a device from the programmer memory.

2. Load a device into the programmer memory.

3. Verify a device against the programmer memory.

4. Check a device for the unprogrammed state.

5. Display checksum of the programmer memory.

6. Display the cyclic redundancy check of the programm
devices.

7. Display the open link count of the programmer memo

8. Download a file to the programmer memory.

9. Upload programmer memory to a file.

10. Apply test vectors to PLD type devices.
StagCom DOS Application
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ry for PLD type devices.
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15.1 Program

Press the P key if you wish to program the selected 
programmer's memory.

Selecting this option will initiate the following:

1. Apply pre-program checks (if they are enabled).

2. Program device from memory.

3. Apply verification checks.

4. Program security fuses (if enabled).

5. Apply test vectors (if applicable).

If a programmer bit mode is selected which is wider than
you will be prompted to specify which device within the set

Select Device 0 to program device with even address data

Select Device 1 to program device with odd address data.

Once programming is completed, the Response Window
the status of the programming attempt.
StagCom DOS Application
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 the selected device, then
 you wish to program.
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 will be updated, indicating
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15.2 Load

Press the L key if you wish to load the contents of th
programmer's memory.

If a programmer bit mode is selected which is wider than
you will be prompted to specify which device within the set

Select Device 0 to load device into even addresses.

Select Device 1 to load device into odd addresses.

Once the device has been loaded, the Response Window
the status of the load attempt.
StagCom DOS Application
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e selected device into the

 the selected device, then
 you wish to load.

 will be updated, indicating
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15.3 Verify

Press the V key if you wish to verify the contents of the s
programmer memory.

If a programmer bit mode is selected which is wider than
you will be prompted to specify which device within the set

Select Device 0 to verify device against even address data

Select Device 1 to verify device against odd address data.

Once the device has been verified, the Response Window
the status of the verify attempt.
StagCom DOS Application
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 the selected device, then
 you wish to verify.
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 will be updated, indicating
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15.4 Blank Check

Press the B key if you wish to check the selected device 
state.

Once the device has been checked, the Response 
indicating the status of the blank check attempt.
StagCom DOS Application
Page 86

against the unprogrammed

Window will be updated,
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15.5 Checksum

Select this option by pressing H if you wish to disp
programmer's memory.

If a programmer bit mode is selected which is wider than
you will be prompted to specify which device within the set

Select Device 0 to display the checksum of data in even a

Select Device 1 to display the checksum of data in odd ad

Once the checksum has been calculated, the Response
indicating the new checksum.

For non PLD type devices, the range of the calculation is
limits, which are displayed in the Device Options group me
see Chapter 13.6 Limits.

For PLD type devices, the range of the calculation is the 
the device.
StagCom DOS Application
Page 87

lay the checksum of the

 the selected device, then
 you wish to checksum.

ddresses.

dresses.

 Window will be updated,

 determined by the device
nu. To change these limits,

fixed to the entire range of
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15.6 Cyclic Redundancy Check (C.R.C.)

Select this option by pressing C if you wish to display the C
memory.

If a programmer bit mode is selected which is wider than t
be prompted to specify of which device within the set you w

Select Device 0 to display the C.R.C. of data in even addr

Select Device 1 to display the C.R.C. of data in odd addre

Once the C.R.C. has been calculated, the Response 
indicating the new value.

Note: This function is not available for PLD type devices.
StagCom DOS Application
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15.7 Open Link Count

Select this option by pressing C if you wish to display 
programmer memory, for the currently selected device.

Once the open link count has been calculated, the R
updated, indicating the new value.

Note: this function is only available for PLD type devices.
StagCom DOS Application
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15.8 Send

Select this option by pressing S if you wish to download a 

Pressing S will display the Send File To Programmer group

By pressing a, use the I/O Formats menu to select the for
want to send to the programmer.

By pressing b, use Ram Start to change the default pro
the first byte of data will be sent.
Note: this option is not available for PLD type devices.

By pressing c, use Ram Size to limit the number of bytes 
to the programmer. The default size is set to the size of RA
so that all data in the file will be stored in the programmer's
Note: this option is not available for PLD type devices.

By pressing d, use Offset to change the run address
programmer. The default run address is the same as the R
Note: this option is not available for PLD type devices.

By pressing e, use the File Name menu to locate the desir

Press Enter key to start the download process, the Progra
shows the progress of file transfer.
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 menu.
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15.9 Receive

Select this option by pressing R if you wish to upload a file

Pressing R will display the Receive File group menu.

By pressing a, use the I/O Formats menu to select the for
want to receive from the programmer.

By pressing b, use Ram Start to change the default progr
the first byte of data will be retrieved.
Note: this option is not available for PLD type devices.

By pressing c, use Ram Size to change the default num
the programmer. The default size = ((device size in devic
mode/8)). This equation covers the complete range of the
mode.
Note: this option is not available for PLD type devices.

By pressing d, use Offset to change the run address of 
programmer. The default run address is the same as the R
Note: this option is not available for PLD type devices.

By pressing e, use the File Name menu to locate the desir

Press Enter key to start the upload process, the Progra
shows the amount of data transferred.
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15.10 Vector Test

Select this option by pressing T if you wish to apply te
device.

This option is only available for PLD type devices. T
downloaded to the programmer first, using a file containing

Once the vectors have been applied to the device, the 
updated, indicating the status of the vector test attempt.
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